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Video Editing Pro - Basics 

After starting “Video Editing Pro”, you must first create a “new project” using the 
wizard (1), create a new project using the specifications of an old project (2) or open 
an existing project (3). 

Existing older projects are provided in the list under (4).  

The button (5) can be used to exit. 

 

 

If a new project is to be created, a storage location (1) and a project name (2) must 
first be selected.  

The default setting for the video quality of the project is selected under (3). 

 

 



 

The desired quality is selected via a default list. 

 

 

After confirming all the default settings, we are taken to the basic interface of “Video 
Editing Pro”. 

 

 

 

 

 

 

 

 

 



Start screen overview 

 

1. main menu 

2. open / save the project and open other sources (from the network, video 
devices or generators) 

3. undo or repeat last actions 

4. shortcut buttons to show or hide certain areas (tabs) of the application  

5. screen recording tool for recording the screen, windows or games so that they 
can then be edited directly in the video editor 

6. tabs/tabs with different areas of the application (tabs can be moved, 
repositioned or rearranged and also closed) 

7. list of filters and effects assigned to a clip or track 

8. current time and total length of the media played in the video player 

9. playback controls of the video player 

10. other areas of the application in the lower half of the video editor 

11. timeline with video and audio tracks  

12. toolbar with important functions for editing the clips on the timeline (e.g. copy 
& paste, cut, delete, zoom, etc ) 



13. history of all actions (undo / redo, see 3.) and Listing of the markers that are 
set at certain points on the timeline 

14. switching workspaces for different tasks (editing, exporting, etc.) 

 

The most important windows in this interface are the library/playlist (2), the timeline 
(3) and the preview window/video player (1).  

Other windows can optionally be switched on or off. 

 

 

 

 

 

 

 

 

 

 



Library, timeline and preview window 
 
The library (2) contains the media files that are to be used in the project. At the 
beginning (1), the window is empty. The easiest way to add files to the list is by drag 
& drop. 
 

 
 
 

The library offers different view options for the added files. 

 

 

 

 

 

 



Once the required files have been stored in the library, they can be processed 
further. To do this, drag the required media into the timeline area. Alternatively, the 
files can also be previewed by double-clicking in the video player. 
 

 
 
 

The timeline consists of several tracks into which audio and video files can be 
inserted and arranged as desired. 

To position the media file within the timeline, it can be moved as required using the 
mouse (1). 

 

 

If a video on the timeline is to be split (cut), this can be done by clicking on the split 
symbol (2). However, you must first use the playback marker (1) to define the 
position at which you want to cut. Cutting is possible at any position. 

 



If there are longer sections in the timeline, the view of the timeline can be minimized 
so as not to lose the overview. 

 

The zoom of the timeline can be changed continuously using the slider (1) or 
adjusted using the button (2) so that all sections are visible.  

 

 

To insert additional audio or video tracks, simply right-click in the timeline or select 
via the menu button (1). 

In the dialog that opens, you can then choose between different track types (2). 

 

 



If editing is to be carried out within a track, the Edit menu (1) can be opened by right-
clicking on a clip. 

Within this menu, it is possible, for example, to separate an existing audio track from 
the video track (2), e.g. to edit the sound separately.   

 

 

Cut away beginning or end  
If the beginning or end of a clip is to be shortened, simply click on at the beginning of 
the clip (a drag marker (1) appears) and drag it to the right. Or go to the end of the 
clip (a drag marker appears), click on the clip and drag it to the left. 
 

 
 
While dragging, you can watch the still image on the clip to see whether it has been 
dragged to the desired position. 
 
 
Note:  
 
To ensure successful editing, you should always note which clip is currently selected. 
The currently selected clip is framed with an orange/yellow line. This can be a clip in 
the timeline or in the library.  

In contrast to the timeline, the library only allows simple edits. However, this can be 
useful for simple edits before inserting them into the timeline. 

 



Adjust properties  
 
It is possible to make further settings for a clip in the properties window. For example, 
if you want to speed up the playback speed of a clip, you can do this as follows:  
 
Select a clip in the timeline (1) then switch to properties (2). 
 

 
 
  
Set the desired higher or lower value in the properties window under Speed (1) or 
Duration (2). 
 

 
 

 

 

 

 



 

The video player menu is used to view/play the material in the timeline. The player 
displays and controls include the following: 

 

 

1) Marking of the current playback position 

2) Playback time and total length 

3) Control elements for the player (1) Start / stop / fast forward, rewind 

4) Enlargement option for the video being played 

5) Settings to display a grid with different content 

6) Volume control during playback 



Summary, work within the timeline:  
 

1) The sequence of the video sequences is defined in the timeline and can also 
be edited there. 

 
2) Drag a clip file from the library or from the preview window into the timeline. 

 
3) Click on a clip to move it by dragging it and arrange the individual clips in the 

correct order. 
 

4) Press the space bar or click on the play button to play the video. 
 
 
Notes: 
 

 The cursor (1) shows the current playback position (2). This can be used to 
quickly navigate to another position. 

 
 Additional audio or video tracks can be added manually using the menu button 

(3) in the timeline. 
 

 Image files can also be placed in the video tracks. 
 

 The icons (4) on the tracks can be used to temporarily mute these tracks or 
hide the image.  

 
 If a track has already been completed, it can be saved or locked using the lock 

symbol (5). 
 

 For better navigation in the timeline, the display size of the timeline can be 
adjusted using the zoom slider (6) in the upper area. 
 

 

 

 



Saving and opening a project 
 

It is important to save the project from time to time in order to save completed tasks. 
 

 
 
 
To save, proceed as follows:  
Click on the "Save" button (2) or click on the menu > File (3) > then Save or use the 
key combination or Ctrl+S. 
 
To open a project, simply click on the "Open file" button (1) and select the folder and 
the project.  
It is also possible by clicking on Menu > File (3) > Open file or by pressing Ctrl+O. 
 
Save project (2) is used so that further edits can be made to this project later. This 
function does not export a video. 
 
 

 

Export project 
 
To save a project as a video, it must be exported.  
The Export button (2) can be found in the main bar in the File menu (1). 
 
Here you can select the output as video (3), among other things. 
 

 
 
 
 
 
 
 
 
 
 



All possible presets are listed on the left side of the export window (1).  

The area to be exported (2) can be selected on the right side. Various settings for 
format, resolution, aspect ratio, images/sec, (3) etc. are also available. It is advisable 
to work with the default settings at the beginning. 

 

Once all settings have been made to your satisfaction, click on the Export file button 
(4) to start the process. 

 

The progress of the process can be seen in the Orders window on the right side. This 
can take anywhere from a few minutes to hours, depending on the duration of your 
video and the export settings you have made. 

 

 



Transitions / fades 
 
Transitions are transitions from one clip to another. If clips are simply lined up one 
after the other on the timeline, no crossfades are created. 
An abrupt or hard cut is made.   
 

 
 
 

If a smooth transition is required, the individual clips can be pushed "into one 
another", which automatically results in a "soft fade" transition. This transition is 
applied to the end of one clip and the beginning of the following clip. 
 
 

 
 
 
The type of fade is adjusted via the Properties tab (1), where other fades such as cut, 
barn door, bar, matrix, iris, box, etc. (2) are available. The softness of the crossfade 
is set using the corresponding slide button (3). Audio settings are made at (4). 
 

 
 
 
A transition can be removed again by clicking on it and pressing the "Remove" 
button. As with editing a clip, the application of a fade or filter is non-destructive, so it 
can be changed at any time. On the other hand, removing creates a gap that must be 
closed manually. Alternatively, the undo function can also be used to remove the 
transition if the transition has just been created.  
 



Add summary transitions:   

 

1) Position two clips next to each other.  

2) Drag one clip over the other. Video Editing Pro automatically creates a fade.  

3) The length of the fade is adjusted directly in the timeline by dragging the 
fades. 

4) Open the properties window. Video Editing Pro offers the option to further 
adjust the aperture and, for example, to choose between different aperture 
types.  

5) To remove an effect, select aperture on the timeline and press the delete 
button or use "Undo". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Add filters & effects 
 
Filters are used in all these cases, whether the video or sound is to be faded in gently 
at the beginning and end, a clip that is too dark is to be brightened or the volume is to 
be changed.  
 
Filters are not separate objects that are positioned in the timeline. Filters are bound 
to a clip. This means that when a clip is moved, the associated filter is also moved. 
Filters can also be assigned to a track, whereby the effect is automatically applied to 
all clips in this track. 
  
To be able to set a filter, a corresponding clip (1) 
must first be selected.  
 
Then open the "Filter" tab (2) and click on the plus sign + (3). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
In the following dialog, the individual filter types (1) and the filter types (2) can be 
selected from the corresponding list. 
 

 
 
 

A preview of the properties of the selected filter may be displayed below (3). 

As soon as one (or more) filters (1) have been selected, you can make individual fine 
adjustments to this filter (2) in the associated menu. 

 

 

 

 

 



Copying and pasting filters 
 

If the same filters are to be applied to several clips, they can be 

be copied by clicking on the button (1) and pasted by clicking on the button (2). (This 
copies all filters!)  

 

 

Inserting text (subtitles etc.) 
 
The easiest way to add text is with the help of a filter. To do this, select a clip and add 
the "Text" filter. The text, font, font size, positioning, etc. can then be defined in the 
filter settings. The text is then only visible for the duration of the clip. 
 
If a text is to be visible for longer than one clip or even over several clips, a text clip 
must be created on a separate video track.  
 
To do this, press Ctrl + I or use the timeline properties (1). A new video track now 
appears above the current track. 
 

 
 
 
 
 
 



Then click on "Open other" (1) in the menu bar and select generator/text (2). 
 

 
 
 
Now enter the text and click OK. 
 

  
 
Only then are all text attributes visible (color, font, size, etc.), which can now also be 
adjusted. 
 
 
 
 
 
 
 
 



The text is now bound to the transparent clip and can be moved freely. 
 

 
 
 
 

 

 



Use of keyframe   
 
With some filters, it is possible to change the settings dynamically.  
 
A classic example is a gentle zoom for photos.  
 
At the beginning, the image should appear in normal size and then slowly become 
larger.  
gradually become larger. Key frames are used for this purpose; these define how 
high a certain value is at a certain time position.  
 
The size is determined at the beginning and end. Video Editing Pro calculates the 
intermediate steps automatically. 
 
 
The "Size, position and rotation" filter is used for the example shown here. If you click 
on the clock symbol (1) next to a value for a filter in the settings, the "Animation" tab 
opens and a track appears below the current clip with the graphical representation of 
the key frames. 
 

 
 
Now place the cursor at the corresponding position and then click on the value. A 
point (keyframe) appears at this point. Such a point can also be created by double-
clicking on the line(2)(3).  
 
The result of the keyframes can be viewed directly in the player.                                                        
 
A keyframe can be changed at any time (move up or down) or deleted again (right-
click). If all keyframes are to be removed, click on the clock symbol again. 
Editing is also possible using the symbols (4) on the left-hand side of the track 
(switch through keyframes, set/delete keyframe). 



Summary, using keyframes 

Key frames can be used to make precise filter settings.  

Select a clip in the timeline.  

 

Apply a filter to this clip (e.g. brightness).  

 

Click on the clock symbol in the filter dialog to display keyframes in the "Animation" 
tab. 

 

Add a keyframe (1) at the desired point in the clip and change the brightness by 
moving the slider for this point in the video.  

Add another keyframe (2) with changed brightness. 

 

Video Editing Pro now fades from one brightness value to the next in the clip. 



Key combination 

All quick access keys available in the program can be viewed in the "Settings" → 
"Actions and shortcuts" menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Appendix: 
 

Filter overview examples incl. mode of operation and instructions for use 
 
VIDEO‐FILTER                   Application 
 
Alpha Channel: Customize    Enlarge or reduce the selection that appears transparent. 

Makes sense in connection with green screen technology. 
 
Alpha Channel: View     Shows the current selection, which appears as transparent. 
 
Alter Film: Scratch              Adds vertical lines. 
 
Alter Film: Grainy             Adds film grain. 
 
Alter Film: Projector          Adds a flickering effect. 
 
Alter Film: Dust                 Adds dust effect. 
 
Alter Film: Technicolor        Adds color saturation, as was common with Technicolor films. 
 
Chroma‐Key: Extended      Inserts a color mask in which a color can be converted to 

transparency. 
 
Chroma‐Key: Simple          Similar above, but with a single color choice. 
 
Opacity                             Makes the clip partially or completely transparent. 
 
Rotate and scale            Rotates and scales the image. 
 
Color matching       Shadows, mids and highlights. 
 
Brightness                               Image brighter or darker. 
 
Overlay HTML                 Used to insert HTML without video or audio. 
 
Hue/Lightness/Saturation    Increases or decreases the basic color, brightness and color 

intensity of the image. 
 
Contrast                               Increases or decreases color contrast. 
 
Lens correction                      Allows the lens of a lens to be corrected (rectification). 
 
LUT (3D)                             Loads a "Look‐Up‐Table" file and applies it to a clip. LUT files 

assign a different color to each color. 
 



 
 
Mask                                 Enables a part of the image to be softly masked. 
 
Reduce noise           Possibly reduces film noise. 
 
Sharpening                   Sharpens the image or makes it blurrier. 
 
Sepia tone                        Color the clip with a yellowish/orange tone. 
 
Saturation                            Strengthens or weakens the colors. 
 
Mirroring                               Flips the video vertically. 
 
Stabilize                         Can normalize a clip. 
 
Text simple    Used to add a simple formatable text, including the field 

commands: Timecode, image number, date, file name. 
 
Text 3D                                Inserts a text that has a 3D effect. 
 
Thread in/thread out video   Used to fade in the beginning or fade out the end of a clip. 
 
Vignetting                       Hides the image after the four corners. 
 
Blurring                    Used to blur the image horizontally and/or vertically. 
 
White balance                     Used to adjust the color of the white light. 
 
Trimming                        Crop image, e.g. to add widescreen effect. 
 
 
And many more   … 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



AUDIO‐FILTER                 Application 

 

Hide audio         Fade sound in and out. 

Balance                             Position the sound between the left and right speakers. 

Bandpass filter                   Cuts highs and lows at spec. frequencies. 

Bass and treble    Boosts or cuts the bass, midrange or treble. 

Delay                                 Inserts an echo effect. 

Expander                           Increases the dynamics of the sound. 

Hall                                   Adds a reverb effect with a variable decay time. 

High‐pass filter                   Cuts all bass below a certain frequency. 

Swap channel          Used to swap the left or right sound channel. 

Notch filter                            Reduces a certain frequency, filters it out. 

Compressor                       This is used to limit the dynamics of the sound and thus make 
quiet passages louder. 

Limiter                              Greatly restricts the dynamics of the sound. 

Normalize (1pass)  Used to raise the loudness of a clip to a desired level with just 
one pass. 

Normalize (2pass)  Used to raise the loudest point to the maximum in two passes. 

1) Determining the volume  

2) Applying the desired volume 

Noise Gate                         The sound is muted below a certain volume. Used to remove 
noise during pauses.  

Panning                            Used to move the sound more to the left or right. 

Silent                               Completely mutes the sound channel of a clip. 

Low‐pass filter     Cuts all highs and mids above a certain frequency. 

Gain volume  Used to raise or lower the volume in general. 

  

 

 


